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How to Edit the Article Page of a Project
Welcome to the How to Edit the Project Article Page tutorial.

In this tutorial, you will learn:
o What the article page is
o How to Edit and customize the Article page
o How to Make the Article the landing page for your project

First, login to your Bay-Delta Live account by using the “Login” button at the top of the
screen.

E m > Register

BAY-DELTA LIVE

Home Operations Current Conditions Weather and Tides Fish Projects Docs Maps Wiki Workgroups Data Catalog Explore Data

Turbidity Conditions in the Sacramento Delta

Understanding salinity and turbidity management allows us to look at things differently, understand
patterns and generate new ideas that might not arise using traditional tools. Users to visualize and
interact on data in new ways and does not mandate that relationships in the data be predefined.

Learn More

Let’s go over what an article page is, how it’s useful, and show a few examples.

The article page is one optional tab of the project page function that allows you to
highlight information from your research or project.

TULE ELKIN THE SACRAMENTO-SAN JOAQUIN DELTA

Recent Activity Article Documents Images & Video Summaries & Reports

Tule Elk in the Sacramento-San Joaquin Delta
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The content is fully customizable. You create your own content by using the provided
tools or input your own HTML.

This function allows you to create an informational landing page unique to your project.
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Who is working on the project?

* Department of Water Resources is leading the effort

as part of the Delta Smelt Resiliency Strategy

The project is a major collaboration between
scientists, modelers and engineers, and inlcudes
staff from DWR, DFW, MWD, SWC, UC Davis, USGS and

several consulting firms.
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Suisun Marsh Salinity Control Gates

Spatial extent of the Suisun Marsh with the salinity control gates mapped. The salinity control gates open and close to let freshwater into the marsh in accordance with
tide. Also displayed on the map is the Critical Delta Smelt Habitat (USFWS).

Suisun Marsh Salinity Control D Suisun Marsh . USFWS Delta Smelt Critical / River & Bodies of Water
Gates Habitat (Liner)
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Now let’s go over how to customize the article page using the tools provided.

Once you create a project page, you can locate it in the project library. To access the
library, click on the “Projects” link on the homepage.

ENN — - IODmE .

BAY-DELTA LIVE

Home Operations Current Conditions Weather and Tides Fish Projects Docs Maps Wiki Workgroups Data Catalog

Explore Data @

Yolo Habitat Conservation Plan - Species and

Habitat Conservation

The Yolo HCP/NCCP will coordinate mitigation to maximize benefits to species, as
well as conserve habitat above and beyond required mitigation for 12 identified
species. The plan strikes a sensible balance between natural resource conservation
and economic growth in the region. This project...

Learn More - D:v!.EL'Ml -

It opens up to the “What’s New” page of the project library. Click on “Search & List View”
in sub-navigation to access the full project library.

Home Operations Current Conditions Weather and Tides Fish Projects Docs Maps Wiki Workgroups Data Catalog

Explore Data @

What's New Add Ne.. Search & List View EcoRestore

PROJECTS
s i P] Wallace Weir | Proj
) y allace Weir Improvement Project
Napa 4 Pl P )
B ] - y [P] The Nigiri Project: Salmon Habitat on Rice Fields
Fairfield X s \
i 1 [P] Managed Agricultural Floodplain Habitat Investigation
Wz “ Lodi [P] Yolo Basin Foundation
Vallejo ‘ g
¢ [P] Prospect Island Tidal Habitat Restoration Project
% 2 Antioch ] ] [P] Fish Barrier at the Knights Landing Outfall Gates
Concord Stockton
# San Joaquin [P] Factors Affecting the Abundance, Community Composition,
2 M's?"l‘m’ Distribution, Availability and Timing of Food for Native Species in
Park -+ Contra Costa Liberty Island
Oakland

: — [P] Restoration of California Deltaic and Coastal Wetlands:
fLrecy Methodology for Quantifying Greenhouse Gas Emissions Reductions
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Find the project you'd like to work with and click, “View Project.”

Home

SEARCH AND FILTER

Data Source

--all---

Search

Type
--all---
Sub Type
--all---
Regions
--all ---
Privacy Settings

Private

@ Map Results

Operations

Current Conditions Weather and Tides Fish Projects

Explore Data @

What's New Add New Search & List View

Docs Maps Wiki Workgroups Data Catalog

EcoRestore

2 Sort: Modifi4 | | Show:6 2 22 Grid = Thumbnail = List Map Results g
My Docs | Public Docs
5
Project Project Project

«

|
Test Project

«

Apr 20,2019 08:25 PM

Restoration

«

O Clear

Reset

Click on the, “Article” tab.

Home

Operations

Current Conditions Weather and Tides Fish Projects

Explore Data @

Tools

Yolo Habitat Nutria Eradication
Conservation Plan
Species and Habitat

Conservation

Apr 09,2019 12:52 PM

View Project

Yolo Habitat Conservancy
[P
Apr 12,2019 11:02 AM

Preservation

View Project

e

Docs Maps Wiki Workgroups Data Catalog

TEST PROJECT

Recent Activity

PROJECT DETAILS
«§ Share & Invite
&+ Follow

Description

Test project for help section.

Article Documents Images & Video Maps

RECENT UPDATES

There are currently no comments.

+ Add Comment

NEW UPLOADS

Keywords: restoration, research, yolo

bypass

Added By: Sarah Dolislager

No new uploads.

Summaries & Reports

MEMBERS AND FOLLOWERS

Dolislager,
Sarah

COMMENTS FROM SARAH
DOLISLAGER

No comments yet.

Revised June 2019




To edit this page, click, “Edit Article” or “Create Article.”

Home Operations Current Conditions Weather and Tides Fish Projects Docs Maps Wiki Workgroups Data Catalog

Explore Data @

TEST PROJECT

) Tools Recent Activity Article Documents Images & Video Maps Summaries & Reports
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You can type information here, and format the text as needed.

If you'd like to change the text size, you can do so in the toolbar using the “Formats” drop-down menu. There are several size and color options.
You can also make the text bold or italic using the buttons on the toolbar, as well as format bullet and number lists, and the text alignment.

If you'd like to make any of the text a hyperlink to another page in BDL, a document, or an external website, simply highlight the text and click on the link icon in the
toolbar.

Paste the link in this box and edit the display text if necessary.

Then click, “OK” to save the changes.

The first option we’ll go over is how to edit the text.
You can type information here, and format the text as needed.

Recent Activity Article Documents Images & Video Maps Summaries & Reports

Editing Article

File~ Edit~ |Insert~ View~ Format~ Tablev Tools~
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You can type information here, and format the text as needed.
If you'd like to change the text size, you can do so in the toolbar using the “Formats” drop-down menu. There are several size and color options.
You can also make the text bold or italic using the buttons on the toolbar, as well as format bullet and number lists, and the text alignment.

If you'd like to make any of the text a hyperlink to another page in BDL, a document, or an external website, simply highlight the text and click on the link icon
in the toolbar.

Paste the link in this box and edit the display text if necessary.

Then click, “OK” to save the changes.

il
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If you'd like to change the text size, you can do so in the toolbar using the “Formats” drop-
down menu. There are several size and color options.

Recent Activity Article Documents Images & Video Maps Summaries & Reports

Editing Article
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hlou can type information here, and format the text as needed.
If you'd like to change the text size, you can do so in the toolbar using the “Formats” drop-down menu. There are several size and color options.
You can also make the text bold or italic using the buttons on the toolbar, as well as format bullet and number lists, and the text alignment.

If you'd like to make any of the text a hyperlink to another page in BDL, a document, or an external website, simply highlight the text and click on the link icon
in the toolbar.

Paste the link in this box and edit the display text if necessary.

Then click, “OK” to save the changes.

p » span

You can also make the text bold or italic using the buttons on the toolbar, as well as format
bullet and number lists, and the text alignment.

Recent Activity Article Documents Images & Video Maps Summaries & Reports

Editing Article

de~ Edit~ Insert~ View~ Format~ Tablev Tools~
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hlou can type information here, and format the text as needed.
If you'd like to change the text size, you can do so in the toolbar using the “Formats” drop-down menu. There are several size and color options.
You can also make the text bold or italic using the buttons on the toolbar, as well as format bullet and number lists, and the text alignment.

If you'd like to make any of the text a hyperlink to another page in BDL, a document, or an external website, simply highlight the text and click on the link icon
in the toolbar.

Paste the link in this box and edit the display text if necessary.

Then click, “OK” to save the changes.

p » span
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If you'd like to make any of the text a hyperlink to another page in BDL, a document, or an
external website, simply highlight the text and click on the link icon in the toolbar.

Recent Activity Article Documents Images & Video Maps Summaries & Reports

Editing Article

File~ Edit~ |Insert~ View~ Format~ Tablev Tools~

€« ® Fomas~ B 7 E E E E -i=- &

You can type information here, and format the text as needed.
If you'd like to change the text size, you can do so in the toolbar using the “Formats” drop-down menu. There are several size and color options.
You can also make the text bold or italic using the buttons on the toolbar, as well as format bullet and number lists, and the text alignment.

If you'd like to make any of the text a hyperlink to another page in BDL, a document, or an external website, simply highlight the text and click on the link icon
in the toolbar.

Paste the link in this box and edit the display text if necessary.

Then click, “OK” to save the changes.

p » span il

Paste the link in this box and edit the display text if necessary.

Insert link X

url | https://baydeltalive.com/assets/5c92b61032e1 l‘

Text to display ‘ If you'd like to make any of the text a hyperlink 1 ‘

Title ‘

Target New window
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Then click, “OK” to save the changes.

Insert link X

url | https://baydeltalive.com/assets/5c92b61032e1 l‘

Text to display ‘ If you'd like to make any of the text a hyperlink 1 ‘

Title ‘

Target ‘ New window

You now have an active link as a part of your Article page.

Recent Activity Article Documents Images & Video Maps Summaries & Reports

Editing Article

File~ Edit~ |Insert~ View~ Format~ Tablev Tools~
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You can type information here, and format the text as needed.
\ If you'd like to change the text size, you can do so in the toolbar using the “Formats” drop-down menu. There are several size and color options.
You can also make the text bold or italic using the buttons on the toolbar, as well as format bullet and number lists, and the text alignment.

If you'd like to make any of the text a hyperlink to another page in BDQ adocument, or an external website, simply highlight the text and click on the link icon
in the toolbar.

Paste the link in this box and edit the display text if necessary.

Then click, “OK” to save the changes.

p » span il
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Remember to always save your changes on the Article page by clicking the “save changes”
button.

Filev Edit~ Insert~v View~ Format~ Tablev Tools~
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You can type information here, and format the text as needed.
If you'd like to change the text size, you can do so in the toolbar using the “Formats” drop-down menu. There are several size and color options.

You can also make the text bold or italic using the buttons on the toolbar, as well as format bullet and number lists, and the text alignment.

1f you’d like to make any of the text a hyperlink to another page in BDL|, a document, or an external website, simply highlight the text and click on the link icon
in the toolbar.

Paste the link in this box and edit the display text if necessary.

Then click, “OK” to save the changes.

p » span

Save Changes Cancel

The second option we’ll go over is how to add a photo.

Toinsert a photo into the article page, you'll need the image URL. This is best done by
uploading photos directly into the Bay-Delta Live library.
Go to the Document Library by clicking on the “Docs” link in the top bar.

E LI — w & Sarah Dolislager

BAY-DELTA LIVE

Home Operations Current Conditions Weather and Tides Fish Projects Docs Maps Wiki Workgroups Data Catalog

Explore Data v

TEST PROJECT

Recent Activity Article Documents Images & Video Maps Summaries & Reports

Edit Article

You can type information here, and format the text as needed.

If you'd like to change the text size, you can do so in the toolbar using the “Formats” drop-down menu. There are several size and color options.

You can also make the text bold or italic using the buttons on the toolbar, as well as format bullet and number lists, and the text alignment.

If you'd like to make any of the text a hyperlink to another page in BDL, a document, or an external website, simply highlight the text and click on the link icon in the
toolbar.

Paste the link in this box and edit the display text if necessary.

Then click, “OK” to save the changes.
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Click “Upload Files” to upload a file from your computer or click on the “Search” in the sub-

navigation to find a photo you’ve already uploaded.

P i oY

BAY-DELTA LIVE

Home Operations Current Conditions

What's New

DOCUMENT LIBRARY

Weather and Tides Fish
Explore Data

Create Download Request

& Sarah Dolislager

Seart

Projects Docs Maps Wiki Workgroups Data Catalog

@

Compilations

Upload Files

Elk Grove . . L
‘ [P] The Knaggs Ranch Experimental Agricultural Floodplain Pilot
Vacaville | Study 2011-2012 Year One Overview application/pdf
N |
203 e [P] Physical Controls on the Distribution of the Submersed Aquatic
tal i Weed Egeria densa in the Sacramento-San Joaquin Delta and
Pl Fairfield > e . "
% Implications for Habitat Restoration application/pdf
12
o= [P [P] Reservoir Operating Rule Optimization for California's
. Sacramento Valley application/pdf
Vallejo .
\ [ B [P] Multi-Purpose Optimization for Reconciliation Ecology on an
SERatael Antioch Engineered Floodplain: Yolo Bypass, California application/pdf
Concord Stockton
san ToAL [P] California Water Action Plan 2016 Update application/pdf
24 Mt Diablo 3 f -
- R [P] Folsom Lake in 2011 and 2014 image/jpeg
Oakland

wan
Legend cisco

Once you locate the image, hover over the Tools button until a drop-down menu appears.

Choose, “URL.”

What's New

SEARCH AND FILTER

Data Source

«

--all---

Search

‘ tule elkl ‘
Media

o

--all ---

Regions

«

--all---

Privacy Settings

«

Private

@ Map Results O Clear

Reset

vave

. |

cu -~ S

e

Create Download Request

Sort: Modifis | Show: 6

_hq;_>

Tule Elk CDR

California Departn
Fish and Wild|

[P]

Mar 04, 2019 09:1

Search

[P] Precipitation Forecasting image/jpeg

Upload Files Compilations

g 22 Grid i= Thumbnail = List Map Results @
My Docs | Public Docs

Image Pdf
View "
Share [
Edit |Management 2018 Elk Conservation
Dublicat and Management Plan

Hplicate 3 Department of
Download and Wildlife California Department of
Fish and Wildlife

Manage Requests P]

, (P
fddto Basket 2019 09:16 PM

Feb 18,2019 09:48 AM

Empty Basket Here

image/png Jage/png
Permalink application/pdf
& -
2%
Delete o
Pdf Pdf Pdf
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A box pops up with the URL and you can highlight, right-click and copy it.

What's New www.baydeltalive.com says

| 5c92b61032e1bfd2c6a30d4ee74773aa/image/png/
SEARCH AND FILTER 2 Tule_Elk_CDFW.png

Data Source

Thumbnail = List Map Results g

“ Public Docs

<«

--all---

Search

|
tule elk mage

Media View
~-all--- Share

«

Regions Tule EIk CDF  Edit |Management 2018 Elk Conservation
—all - s Duplicat and Management Plan
: : California Departy PUPlcate 3 Department of
Privacy Settings Fish and Wildl pownload and Wildlife California Department of
- Fish and Wildlife
Private v ] Manage Requests [Pl ! e
[P]
Mar 04,2019 09:;; Add to Basket 2019 09:16 PM
@ Map Results O Clear Empty Basket Here Feb 18, 2019 09:48 AM
image/png - Jage/png
Reset Permalink application/pdf
© URL 24 .
Delete o

vaves

~ ‘ _ Pdf

Pdf Pdf

Now go back to the article page of the project you were working on.

Click “Edit Article.”

VXN -

BAY-DELTA LIVE

Home Operations Current Conditions Weather and Tides Fish Projects

Explore Data @

TEST PROJECT

€¢€C

Docs Maps Wiki Workgroups Data Catalog

e | <

You can type information here, and format the text as needed.

If you'd like to change the text size, you can do so in the toolbar using the “Formats” drop-down menu. There are several size and color options.
You can also make the text bold or italic using the buttons on the toolbar, as well as format bullet and number lists, and the text alignment.

If you'd like to make any of the text a hyperlink to another page in BDL, a document, or an external website, simply highlight the text and click on the link icon in the

toolbar.
Paste the link in this box and edit the display text if necessary.

Then click, “OK” to save the changes.

1 Tools Recent Activity Article Documents Images & Video Maps Summaries & Reports
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If you'd like to insert an image, simply click on the “Insert” drop-down menu and choose,
“insert/edit image.” Or, you can click the image icon in the toolbar.

Recent Activity Article Documents Images & Video Maps Summaries & Reports

Editing Article

—-Hl!—» Insert ~ l View > Format~ Table~ Tools ~

« P  Fop Plnsertfeditlink K =

E=-g-2 =2 o|u|<

[Ad] Insert/edit image

You can type [] Anchor text as needed.

If you'd like to change the text size, you can do so in the toolbar using the “Formats” drop-down menu. There are several size and color options.
You can also make the text bold or italic using the buttons on the toolbar, as well as format bullet and number lists, and the text alignment.

If you'd like to make any of the text a hyperlink to another page in BDL, a document, or an external website, simply highlight the text and click on the link icon
in the toolbar.

Paste the link in this box and edit the display text if necessary.

Then click, “OK” to save the changes.

Eil

Paste the URL here and the dimensions will automatically fill.

Insert/edit image X

Source ’ https://www.baydeltalive.com/assets/5:

Image description ’ ‘

Dimensions X Constrain proportions
cae
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Click, “OK” to save your changes.

Insert/edit image X

Source ’ https://www.baydeltalive.com/assets/5:

Image description ’ ‘

Dimensions X Constrain proportions

Once the image is in the body of the article page, you can click on the corners and adjust
the size this way too.

nuie wuwar.

Paste the link in this box and edit the display text if necessary.

Then click, “OK” to save the changes. /
-—
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As you're working on the Article page, remember to periodically save changes. Click on
the “save changes” button.

Then click, “OK” to save the changes.

p » span /

Save Changes Cancel

The third option we’'ll go over is how to embed videos into an article page.

The easiest way to embed a video is to upload the video to YouTube or Vimeo and use the
embed code.

For YouTube videos, you can find the embed code by clicking “share” and then “embed”
under the video player.

North Delta Food Web Action - Ted Sommer

21 views ﬁ A SHARE || = save
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Message on YouTube

To: Search for people.

AT eh

Share a link

-1 @O000E6:

Facebook Twitter Blogger reddit Tumblr

https://youtu.be/mhWSy_y5NIl

D Start at

The code will look like this:

Embed Video X

<iframe width="560" height="315"
src="https://www.youtube.com/embed/mh
WSy_y5N1I" frameborder="0"
allow="accelerometer; autoplay;
encrypted-media; gyroscope; picture-

in-picture” allowfullscreen></iframe>

O startat

COPY
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Copy it and go back to the article page you are editing.

You will paste the embed code into the HTML code. To edit the HTML code, click on the
“Tools” drop-down menu in the editing toolbar.

Recent Activity Article Documents Images & Video Maps Summaries & Reports

Editing Article

File~ Edit~ Insert~ w Tools ~
“ o ormee B 7 Ex 3 aKEIETEEE s ®

Spellcheck

You can type information here, and format the text as needed.
If you'd like to change the text size, you can do so in the toolbar using the “Formats” drop-down menu. There are several size and color options.

You can also make the text bold or italic using the buttons on the toolbar, as well as format bullet and number lists, and the text alignment.

1f you'd like to make any, of the text a hyperlink to another page in BDL, a document, or an external website, simply highlight the text and click on the link icon
in the toolbar.

Paste the link in this box and edit the display text if necessary.

Then click, “OK” to save the changes.

Choose, “Source code” and a box will pop up with the HTML code.

Recent Activity Article Documents Images & Video Maps Summaries & Reports

Editing Article

File~ Edit~ Insert~ -ﬁ—u—ﬁ-m_ﬁb» Tools ~

€« 7 fomats B 1 =E E = I <> Source code E P =
Spellcheck

You can type information here, and format the text as needed.
If you'd like to change the text size, you can do so in the toolbar using the “Formats” drop-down menu. There are several size and color options.
You can also make the text bold or italic using the buttons on the toolbar, as well as format bullet and number lists, and the text alignment.

1f you'd like to make any, of the text a hyperlink to another page in BDL, a document, or an external website, simply highlight the text and click on the link icon
in the toolbar.

Paste the link in this box and edit the display text if necessary.

Then click, “OK” to save the changes.
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Find the part of the page you'd like to embed the video and simply paste the embed code.

HTML source code

i DLl oo o L

<iframe width="560" height="315" src="https://www.youtube.com/embed/mhWSy_ y5N1I" frameborder="0"

allow="accelerometer; autoplay; encrypted-media; gyroscope; picture-in-picture” allowfnllscreen></iftameﬂ
s S hoy B et p ey ne Aoy oo o o " <pa- e ssiempae ST <o

</p>

<p><span style="font-weight: 400;">If you’d like to change the text size, you can do so in the toolbar

using the “Formats” drop-down menu. There are several size and color options.</span></p>

<p>You can also make the text bold or italic using the buttons on the toolbar, as well as format bullet

and number lists, and the text alignment.</p>

<p><span style="font-weight: 400;"><a

href="https://baydeltalive.com/assets/5c92b61032elbfd2c6a30d4ee74773aa/image/png/Tule_Elk_CDFW.png"

target="_blank">If you’d like to make any of the text a hyperlink to another page in BDL</a>, a document,

or an external website, simply highlight the text and click on the link icon in the toolbar.</span></p>

<p><span style="font-weight: 400;">Paste the link in this box and edit the display text if necessary.

</span></p>

<p><span style="font-weight: 400;">Then click, “OK” to save the changes.</span></p>

<p><span style="font-weight: 400;"></span></p>

<p><span style="font-weight: 400;"><img

src="https://www.baydeltalive.com/assets/5c92b61032elbfd2c6a30d4ee74773aa/image/png/Tule_Elk_CDFW.png"

alt="" width="487" height="265" /></span></p>

aucymae) sa-m e e s Serepa

Then save your changes by clicking, “OK.”

w

IS

v

o

~

v ®

10

ali0w= accelerometer; autop.iay; encryptea-mealia; gyroscope; plCture-in-picture a.llowruilscreen></ ].Irm)l
<p><span style="font-weight: 400;">You can type information here, and format the text as needed.</span>
</p>

<p><span style="font-weight: 400;">If you'd like to change the text size, you can do so in the toolbar
using the “Formats” drop-down menu. There are several size and color options.</span></p>

<p>You can also make the text bold or italic using the buttons on the toolbar, as well as format bullet
and number lists, and the text alignment.</p>

<p><span style="font-weight: 400;"><a
href="https://baydeltalive.com/assets/5c92b61032elbfd2c6a30d4ee74773aa/image/png/Tule_Elk_ CDFW.png"
target="_blank">If you’d like to make any of the text a hyperlink to another page in BDL</a>, a document,
or an external website, simply highlight the text and click on the link icon in the toolbar.</span></p>
<p><span style="font-weight: 400;">Paste the link in this box and edit the display text if necessary.
</span></p>

<p><span style="font-weight: 400;">Then click, “OK” to save the changes.</span></p>

<p><span style="font-weight: 400;"></span></p>

<p><span style="font-weight: 400;"><img
src="https://www.baydeltalive.com/assets/5c92b61032elbfd2c6a30dd4ee74773aa/image/png/Tule_Elk_CDFW.png"
alt="" width="487" height="265" /></span></p>
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You'll see your video is now embedded into the article page and can be played at any time.

Filev Edit~ Insert~ View~ Format~ Table~ Tools~
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®  North Delta Food Web Action - Ted Som... o ~»
> Watch later  Share

You can type information here, and format the text as needed.

If you'd like to change the text size, you can do so in the toolbar using the “Formats” drop-down menu. There are several size and color options.

You can also make the text bold or italic using the buttons on the toolbar, as well as format bullet and number lists, and the text alignment.

If you know how to use HTML, you can click on the “Tools” drop-down menu in the
toolbar and choose, “Source Code” to make any changes to the code.

File~ Edit~ |Insert~ View ~ m Tools ~

c Formats B 7/ = -

Spellcheck

L B

®  North Delta Food Web Action - Ted Som... o ~»
L Watch later  Share

You can type information here, and format the text as needed.

If you'd like to change the text size, you can do so in the toolbar using the “Formats” drop-down menu. There are several size and color options.

You can also make the text bold or italic using the buttons on the toolbar, as well as format bullet and number lists, and the text alignment.
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Finally, let’s go over how to make the article tab the landing page for your project.

If you'd like people to see the Article page first when they view your project, you can do so
in the metadata editor form.
Hover over the Tools button for the project and choose, “edit.”

TEST PROJECT
Recent Activity Article Documents Images & Video Maps Summaries & Reports Filters Graphs
Share
Map It
1
PROJECT DETAILS RECENT UPDATES MEMBERS AND FOLLOW] Edit
|
Embed / Preview
<share & Invite There are currently no comments. AddewFile
&+ Follow Add Files to Proj

.~
Dolislager, .
+ Add Comment SME A Add to Basket

Keywords: grizzly island, restoration, Empty Basket H

habitat WorkSpace
. h Dolisl NEW UPLOADS Permalink

Added By: Sarah Dolislager COMMENTS FROM SARA “

Date Added: May 28, 2019 09:26 PM DOLISLAGER belete

Last Edited By: Sarah Dolislager

" No comments yet.
Last Edited: Jun 26,2019 08:19 PM No new uploads. Y

Privacy: Private

Additional Attributes
Latitude: 38.144938824032266

Longitude: -121.94607696290537

There are several tabs on the metadata editor form. Click on the “Layout” tab.
— EDITING TEST PROJECT x

_in | Layout | Map It! | Publish? | Organize | Video/Embed | Project Info
pit | Publsh? | org j

Title
Test Project
Caption/Short Description

Description

Web Link (Opens a new window)

Meta Data URL
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There you will see a “Default View” drop-down menu. Choose, “Article” from the options.

Then click “save changes.”

EDITING TEST PROJECT

Save Changes Cancel

Main | Lavout [ Map It! | Publish? | Organize | Video/Embed | Proiect Info
Default View

"

ARTICLE

Content Tabs
select all / deselect all
@ ARTICLE @ MAPS
v

v
@ IMAGES / VIDEO SUMMARY/REPORT
@ RECENT ACTIVITY @ DOCUMENTS
@ GRAPHS ¥ FILTERS
Content Addons

--none --

Story

EC Dashboard

Turb Dashboard

Save Changes Cancel

EDITING TEST PROJECT

Save Changes Cancel
mm Publish? Video/Embed | Project Info [

Default View

"

ARTICLE s

Content Tabs
select all / deselect all
¥ ARTICLE @ MAPS
7]

v
@/ IMAGES / VIDEO SUMMARY/REPORT
@ RECENT ACTIVITY @ DOCUMENTS
@ GRAPHS ¥ FILTERS
Content Addons

--none --

Story

EC Dashboard

Turb Dashboard

Save Changes Cancel

Now if you go to open up your project page from the project library, you'll see that it

opens up to the “Article” tab.

This concludes the “How to Edit the Project Article Page” tutorial.

Revised June 2019 20



